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PRIMENA RACUNARA U ELEKTROTEHNICI

ELEKTRONICIWORKBENCH ic program napravijen za analizu razlicitih

elektriénih i elektronskih kola,koji omogucuje korisnicima da kompjuterski analiziraju
rad uredaja koji ih interesuju.Na primer ,ako je u pitanju audio pojacivac,program
izracunava i prikazuje jednosmerne i naizmeni¢ne napone u svim tackama,crta
frekvencijsku karakteristiku i td.

Izgled radne povrsine programa WorkBench-a dat je na slici:
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Prva linija. je linija na kojoj piSe ime programa.
Druga linija. Na radnoj povrsini je MENI BAR koja sadrzi nekoliko kartica:
File Edit Circuit Analysis Window Help

Na primer ako se klikne na Circuit otvara se njen meni:
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TGOS —

File Edit | Circuit | Analysis Window Help

D B’“I Rotate Ctrl+R |1§_*}|£| ‘Eil Gl
Flip Horizontal —
Be| 3 Flipvertica | | | M |
Untitled Component Properties...
Create Subcircuit... Ctrl+B
Zoom In Ctrl++
Zoom Cut Ctrl+-

Schematic Options...

Udesnom uglu ekrana je Glavni prekida¢ i dugme Pause.

U liniji Libraries na slici ispod nalaze se biblioteke sa komponentama elektronskih
uredaja,indikatorima,istrumentima,kontrolnim blokovima i sl.
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BIBLIOTEKA SOURCES.

Kada se u liniji sa bibliotekama klikne na biblioteku Sources dobice se slika:

| & Sources E
@|

|
~|=[®|@|@)| solac|aclad| vr[4|
®|B| S| S| | & |Bs /s

To je sadrzaj ove biblioteke u kome su komponente prikazane kao slike u obliku u kome
¢e se pojaviti na crtezu
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=
—l GROUND.Njime se obelezava referentna tacka u odnosu na koju se mere
svi naponi.

wle
T

BATTERY.Baterija,izvor jednosmerne struje &iji je napon konstantan.

J@ DC CURRENT SOURCE.lIzvor konstantne jss.bez obzira kolika je otpornost
prikljuéenog potroseca.

@ AC CURRENT SOURCE.izvor konstantne

URCE.izvor

amplitudsko-modulisanog signala @
SOURCE.izvor frekvencijski modulisanog signala.

naizmeni€ne struje

Yoo

.I *V.. VOLTAGE SOURCE.izvor jednosmernog

“Wold
napona od 5V. .| )L TAGE SOURCE.izvor

jednosmernog napona od 15V
BIBLIOTEKA BASIC.

Sadrzaj ove biblioteke prikazan je na slici:

(=]
o [l 4|38 B|-=|-=[ew ¥
| R 0 || o2 io|mm|3E]

Specificne komponente su:

-
—-—
T

Connector-tacka u kojoj se spajaju krajevi viSe komponenti.Promenljive komponente iz
biblioteke Basic prikazane su na slici:
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KarakteristiCna veli¢éina ovih komponenti smanjuje se tako Sto se na taststuri pritisne
dirka sa slovom koje se nalazi u srednjoj zagradi u oznaci iznad komponente.Poveéanje
vrednosti vrSi se tako Sto se drzi dirka Shift i dirka na odgovaraju¢éem mestu.Na primer

R/MKQ/50%

Prema ovoj oznaci za pomeranje kliza¢a treba pritiskati R,tada se broj u procentima
smanjuje(50% pokazuje da je kliza€ bio na sredini.), a SHIFT i R za poveéanje procenta.

BIBLIOTEKA INDIKATORS.

Sadrzaj ove biblioteke prikazan je na slici:

B Indicators

3| | @\I\l\ﬂ\i\l\

1.VOLTMETAR se koristi za merenje jednosmernog napona ili efektivne vrednosti
naizmeniénog napona izmedu tac¢aka .Deblja strana pravougaonika oznake voltmetra
prestavlja negativan priklju¢ak.Specifikacija rada postize se tako sto se dva puta klikne
na sliku voltmetra.Otvara se dijalog Voltmetar Properties

Woltmeter Properties Send Feedback | 7 |—$-:hj
Label ] Value Fault l Display]
=
i
v 1 I 2
" Leakage IT IQ—IZ
" Shart
" Open
* Mone
QK | Cancel |

Dijalog ima Cetri jezicka:LABEL...VALUE...FAULT DISPLAY
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MODE(AC ili DC)

2.AMPERMETAR se koristi za merenje jednosmernih struja ili efektivnih vrednosti
naizmeniénih struja.Prikljuc¢ak spojen sa debljom stranicom je negativan priklju¢ak.Ako
se pri merenju jednosmerne struje pojavi negativan broj,to znaci da struja tece u
suprotnom smeru.

Ammeter Properties Send Feedback l 2 |ﬁh]

Label Value |Fautt | Display |

Rezistance [R): |mQ E
Mode: o -

oK | Cancel |

3.SIJALICA je pretvarac el.energije u svetlosnu energiju.Obi¢no su date u programu za
10W i 12V,ali ove vrednosti mogu da se promene tako Sto se dva puta klikne na nju.Ako
je napon koji se dovodi na nju manji od polovine,sijalica ne svetli,ako je veéi od
dozvoljenog sijalica

4.Na slici su(voltmetar,ampermetar,sijalica,crvena sonda,7-C displej,bazer i dekodiranidisplej.)

uuuuuuuuuuj}i]Q @! I

5.CRVENA SONDA sastoji se od jedne LED diode i zastitnog otpornika vezanog na
red.Jedan kraj te veze spojen je sa MASOM,a drugi kraj je prikljuéak koji postoji na slici
sonde.Kada se na ovaj kraj dovede pozitivan napon veéi od 2.5V,dioda svetli crveno Ako
je napon manji od 2.5 dioda je ugasena.Sonda se najviSe koristi u analizi digitalnih kola
,gde se koristi da se proveri da li je u nekoj tacki kola logi¢ka jedinica(napon veéi od

2.5V) ili je logi¢ka nula.
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6-BAZER(ZUJALICA) je komponenta koja stvara slozeni ton u obliku zujanja. Ona poc¢inje
da svira kada mu se na prikljucke dovede odgovarajuci jss napon.

BIBLIOTEKA INSTRUMENTS.

B Instrurnents [Te=]

]

(=l=pn =]

k=]
2 E=2
k=]

 M—

|
L= ] (==

== OIS
L= g lule)

L= ==

Sadrzaj ove biblioteke je sledeéi:multimetrar...osciloskop...generator funkcija

ploter
logi¢

ki analizator...generator reci logic¢ki konvertor.

MULTIMETAR.

Multimetar je instrument koji se najéesée koristi u praksi,jer omogucéuje brzo i lako
merenje struje napona i otpornosti.

>

B Instruments [==]
E I:I | x o fulalsla}
= s e 5

B Multimeter 23 |

| Alm o ] |
e | =
Settings

- +
. Cl

O] [

Vrsta merenja bira se tako Sto se klikne na odgovarajué¢u dugmad(ovde je izabrana
horizontalna crta simbol za jss)Biranje odgovarajuéeg mernog opsega vrSi se
automatski.Pritiskom na dugme Settings otvara se dijalog koji omogucéuje da se promene
otpornosti ampermetra i voltmetra,struju koja prolazi kroz komponentu i sl.
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Multimeter Send Feedback l ? |_il?—l
Sheet 1
Ammeter rezizgtance [R]: ]nQ E
Woltmeter resistance (R} |1 ]GQ =
Ohrameter currant [1]; ||:|_|:|‘| ]I-lf-"- E
Decibel standard [ |1 ] W =
ok | cancal |
GENERATOR FUNKCIJE.
Generator funkcije je uredaj koji stvara naizmeniéne napone:sinusnog,trougaonog i
pravougaonog NAPONA.
] Instruments 22|
PN ol Lo
Bl [ Function Generator |£|

Freauancy
Duty oycle [50 [] =
senpituce [10 3 [v 3
oftst [0

— Comman

+
03 = (=

Vrsta napona se bira tako sto se klikne na jedno od dugmeta na kome su nacrtani oblici
napona.U¢éestanost napona moze da se menja od 1-999Hz , a amplituda od 1V do 999kV.

NAPON odredenog talasnog oblika dobija se izmedu priklju¢aka + i kraja Common.

OSCILOSKOP.
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Osciloskop je elektronski uredaj koji omogucéuje da se vide talasni oblici napona,kao i da
se izmere njihove amplitude,u¢estanosti,fazne razlike i td.

Osciloskop se otvara na isti naéin kao i predhodni instrumenti.

IE 2 B.] Oscilloscope =
o0
Expand Ground (=
—Time base Trigger
[0.50 =/div £l | Blge El x| =
X position | 0.00 = | Lewel
; —Channel & ——————— Channel B
[ 5 wOiw [ 5 wiDi

12A0

J210

¥ position | 0.00 ¥ position | 0.00

scio i = | sa[oEE @

Kod osciloskopa je najvaznije podesiti:
.Time Base(vremenska baza)

+Osetljivost osciloskop
Podesavanje TB.

Na slici iznad TB je podesena na o0.5s/Div/ipodeokul/,gde je podeok rastojanje izmedu dve
uspravne linije.Vremenska baza podesava se prema formuli:

Time Base=1/4f.
.Na primer ako je f=50Hz vrednost TB=1/4*50=0,005s/Div=5ms/Div
lli ako je f=800Hz vrednost TB=1/4*800=0.3125us/Div,uzeti prvu veéu vrednost od 0.5us/Div
Podesavanje osetljivosti kanala osciloskopa.

Na slici gore osetljivost oba kanala podesSena je na 5V/Div .gde je podelak rastojanje
izmedu dve horizontalne linije.

‘—Ehannel A — Channel B
I| 5 W/Diu =] 5 wiDiv =

U praksi OSETLJIVOST treba podesiti na vrednost:

OA~U.x/2.
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,gde je OA osetljivost.

Na primer ako posmatramo mrezni napon tada je amplituda napona
Unax=220%1.41=311V,pa se osetljivost mora podesiti na polovinu od ove vrednosti
155.5V/Div,odnosno njoj najbliza vrednost od 200V/Div.

Osciloskopom mogu istovremeno da se posmatraju dVanapona.

il Occilloscope -_§§-
. wr

AN
/ b

~]
A

| A
T 19 B372 m=s T2 19 8374 m=s T2-T1 125 BEHEE n=s
il 9.9178 W Rrivd 7 .5474 W WA -2 .8389E W
WH1 4 5174 ! B2 &, 9545 ) “wH2-4H1 2. 4469 !
— Time base Trigger Channel # —————————— Channel B
0,200/ di | Edge  EE = [ 5 v/Diu =[5 wiow [] | Reduse |
¥ position Lewrel 0.00 H ¥ position | 0.00 H ¥ position | 0.00 E Rewversa
EER 035 | A BON Al Ee] | AC|0|HE A 0 |ER save

Jedan od njih dovodi se na ulaz WlKanallA a drugi na ulaz KanalB

Pritiskom na dugme EXpand dobija se uveli¢ana slika prednje strane osciloskopa,slika iznad.
Trenutna vrednost amplituda i uéestanos pomocu osciloskopa mere se na sledeci nacin:

Pointer se postavi na mali trougao crvene boje i postavimo ga na odredeno mesto,kao na
slici dole.Taj polozaj odgovara vremenuT1=14.7725s a polozaj 2 odgovara vremenu

T2=14.7825.Dakle razlika vremena je T2-T1=10ms,pa je uéestanostf=1/10ms=100Hz.



5| Oscilloscope 2=
L el

ki ]
Ti 14 2725 = T2 14 2225 = Tz-T1 18. 8688 m=s
RTh| 3.8723 W Wit 2.8723 W Rt | 1.5548 pV
WH1 WH2 WHZ-WE1
—Time base Trigger Channel A Channel B
[5.00me/ div 5| | Edge EE %] | & “/Diu = | [ 5 woiv %] | FReduce |
X position | 0.00 2| Lewel 0.oo [l | f position | 0.00 =1 | position | 0.00 = Reversze |
T BN #[5/ex] | ac|oEH 420 EH save

Slika koja se dobija ne ekranu osciloskopa stalno je u pokretu,zaustavlja
se SaPAUSE. AMPLITUDA signala dobija se kao Up.=5V/pod*2pod=10V

CRTANJE ELEKTRICNE SEME.

Da bi nacrtali prostu elektricnu Semu,treba uraditi sledece: Iz biblioteke Sources klikom
levog mis$a prevuéi iz palete izvor od 12V na radnu povrsinu,zatim iz biblioteke Basic
dovedemo otpornik ,a iz.

1 k Ohm

biblioteke Indikators dovedemo ampermetar.
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Otpornik treba da stoji uspravno,kliknite na njega ,tako da pocrveni,a zatim desni klik i iz
menija pritisnuti Rotate.

Sledecéi korak je povezivanje komponenti.Vrh kursora se postavi na kraj pozitivhog
priklju¢ka baterije,tako da se pojavi mali crni krug.Pritisne se i drzi pritisnuto,levo
dugme.Mis se pomera i pojavljuje se linija,to jest ZICA.Mi$ se pomera dok vrh zZice
ne dode na vrh levog prikljucka ampermetra,tako da se i ovde pojavi mali crni
krug.Dugme se otpusti,kosa linija se automatski pretvara u izlomljenu liniju i na
ekranu je slika:

Klikom na glavni prekida¢, ampermetar ¢e da pokaze struju ja¢ine od 12mA,sto je tacno i
po Omovom zakonu:I1=U/R=12/10000=12mA,éime smo proverili Omov zakon,slika
dole.
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12.00m A&,

Nekad se moze ukazati potreba da se neki elemenat Seme pomeri,da bi pored njega bio
postavljen jos jedan element.To se radi tako Sto se kursor postavi na otpornik.pritisne i
drzi levo dugme.Otpornik se pomeri u novi polozaj dole(,slika ispod).Ako zelimo da
otpornik od 1kQ pomerimo na gore,kliknemo na njega i kuckamo strelicu na gore na
tastaturi.

[ 1z00mA]

| Zica se moze postaviti u novi polozaj.Tako se vrh kursora postavi taéno na zicu i
pritisne,kursor menja oblik u dvoglavu strelicu,pomeramo misa na dole i pustimo
misa:donja zica je pomerena na dole.

[ tzoomAll

Brisanje komponenti moze da se obavi na sledeéi nacin:Pritisne se levim dugmtom na
komponentu tako da ona pocrveni,pa desnhim klikom i iz pomoénog menija izabrati
Delete.



EDITOVANJE KOMPONENTI.

Pagel|14

Po difoltu baterija ima napon od 12 V,a otpornik od 1kQ.Dva puta brzo kliknemo na

bateriju i na ekranu se pojavijuje Battery Proprerties u kome treb kliknuti na

Value,obrisati 12 i napisati 24V pa OK.Zatim to ponoviti i za otpornik i podesiti otpor

na 100 Q,pa pritisnuti OK.

Battery Properties Send Feedback IEI

Label Walue | Fautt | Display | Analysis Setup |

Waltage [v): |24 J [ B
e

Yaoltage tolerance:  |Global

v Uze global talerance

oK | Cancel
Resistor Properties Send Feedback
Label Value |Fautt | Display | Analysis Setup |

Resistance [R]: 100 MF:
First-order temperature coefficient [TC1): 1] Qi
Second-order temperature coefficient [TC2): |0 Qe
Resistance tolerance: Global % ¥ Use global tolerance

oK | Cancel

Klikom na desno dugme 1 u Workbench-u,ampermetar pokazuje novu vrednostost.
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240.0m A,

— v §1un ohm

Sada pored svake komponente treba upisati njenu oznaku.Kliknemo dva puta na
bateriju i u okviruBattery Properties na jezi¢ku Lebel ukucati U1.

Battery Properties Send Feedback l P

Label ]‘u"alue ] Fault ] Display] Anahysis Se‘tup]

Label I'\."1

Reference 1D [v1

oK | Cancel

Zatim to isto uradimo i sa otpornikom:

Resistor Properties Send Feedback l PR X

Label ]Value ] Fault ] Display] Analysis Setup]

Label Fi|
Reference 1D 1H1

0K | Cancel

Sada je Sema kompletirana:
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100 Ohm

VEZBA 1.
Na crtezu sa gornje slike dodaéemo jos jedan otpornik i jos dva ampermetra.

=i
Ml

i L 7
1 K LIhm

12.00m A, SVAVAY
R2 e
2 k Ohm L
2w Lnm
24V

Ampermetar kroz R1 pokazuje 12mA,a kroz R2 i R3 po 6mA.Dakle vazi prvi Kirkohov
zakon.Proverite $ta ¢e se dogoditi ako prikljucite izvor naizmeniénog napona AC Voltage

Source .Ne zaboravite da ampermetre pfébacite'na’AC.

1 k Ohm
50 99m A Ay
R2
= 2k Ohm k'“.;?r
@1:-%-‘@3 Hz/0 Deg =

KORISCENJE INSTRUMENTA.
U praksi se najéesée koriste MULTIMETAR...GENERATOR FUNKCIJA...i OSCILOSKOP.
VEZBA 2.
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MULTIMETAR:

EWB multimetar koristi se na isti nac¢in kao i stvarni multimetar.Kada se meri
napon,njegove sonde,spoje se sa tatkama u kolu,izmedu kojih treba izmeriti
napon.Kao primer prikazano je kolo u kome se meri napon na potrosac¢u R3.Pritisnuto

je dugme V.

23 B Multimeter [ 22 |

[ AR o | |

=S

Se‘rtingsJ
o) T 3y +
(" (0}

Na isti nac¢in kako je izmeren napon izmedu tacaka 3 i 4 moze da se izmeri napon
izmedu bilo kojih drugih tacaka.Posto je napon 3.2727V mogucée je naci struju kroz

otpornik R3: 1,=U3/R3;=3.27mA

Da bi ovu struju izmerili multimetrom,prebacimo ga na A,raskinemo granu sa otpornikom
R3 i ubacimo ga u kolo na red sa R3:Ako bi sonde zamenile mesta(donja slika) na
displeju bio bio negativan broj,Sto je znak da struja kroz instrument ne te€e od plusa ka

minusu ve¢ obratno..
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[ Mol o8] ]
Settings

4
0}

2k Ohm 1 k Ohm
A o -
- 12¥ Sl B Multimeter [ 23
e

wl

Redni brojevi évorova na slikama mogu da se izbriSu,tako sto se desnim dugmetom
klikne na prazno mesto na crtezu.Pojavljuje se pop up meni na kome treba kliknuti na
Schemetic Options,zatim naShow/Hide i od¢ekirati Show Nodes.Naizmeniéni napon i
struja mere se na isti na¢in ,samo sto na multimetru treba kliknuti na dugme sa

sinusoidom.
MERENJE OTPORNOSTI.

Otpornost se meri tako Sto se multimetar priklju€i na bilo kakvu vezu
otpornika.Multimetrom mogu da se izmere otpornosti samo U KOLIMA BEZ
NAPAJANJA.U kolu sa slike ekvivalentni otpor mozemo naci iz pokazivanja ampermetra

i vrednosti napona napajanja.

—i 6.000m A, I L g

A)
R.=U/1=2kQ.
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B)Ako otka¢imo napajanje mozemo izmeriti diraktno ulaznu otpornost,samo
moramo pritisnuti dugme na instrumentu Q.

B Multimeter | 22

Al v 8| |

Ll — |
Settings

GENERATOR FUNKCIJA | OSCILOSKOP.

Iz biblioteke Sources dovesti na ekran komponentu Ground ,a iz biblioteke Instruments
dovesti Function Generator i Oscilloskope i povezati ih prema slici:Na osciloskopu
podesiti vremensku bazu kanala A na 5ms/Div a osetljivost na 5V/Div.Na isti na€in na
generatoru podesiti ucestanost na 50 Hz a amplitudu na 10V.Dobi¢emo sledecu sliku:
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[E Oscilloscope

=]
[ ~7
| e
= n
: av
l
7| Function Generatar @
| A
| | | RN |
Ti B.e680 = T2 29 .EB4é8 = TET1 29 .EB4é8 =
Frequency wal | -18. 8888 U L 16 8888 AT 2@.80868 U
Duty cycle (50 [ & w1 B2 WHZ-WH1
Ampltade 10 [ [ v [ —Time base Trigger Channel & Channel B -
o [0 [ Soovsidy | e MM =l |[5 viDi = | =] Reduee
- Eonieaan + ¥ position Lewvel 0.00 : |;_|‘ i position | 0.00 |z|‘ Y position | 000 II" Rewerse
& & & MR oo %o | AliEa] | sc|o)HE sc|o | e |

Kada se ukljuci glavni prekida¢ pravougaoni impuls se brzo krece preko

ekrana,zaustaviti ga sa Pause.Pritisnuti dugme Expand da slika zauzme ceo ekran
osciloskopa.

Proracun sa dijagrama.

Amplituda signala na ekranu je 2 Div(podeoka),pa je
U=2Div*5V/Div=10V Perioda T je T=4Div*5ms/Div=20ms
Ucéestanost f=1/T=50Hz

AMPLITUDSKI MODULISAN SIGNAL(AM SIGNAL).

Povezite generator AM signala,masu i osciloskop.Podesite vremensku bazu i
osetljivost kanala na vrednosti sa slike.Ukljucite glavni prekida¢,prosirite sliku
osciloskopa.
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1] Oscilloscope S@ ._:
hid hid

Kl i
T B.8088 s T2 2.8281 s Ti-T1 2.8281 s
it 481 . 2804 mV AR [ 7594984 ml SRt 278 2182 mV
“H1 “H2 “H2AE
r—Time baze Trigger Channel A Channel B
2.00ms/div E Bige B x| 500 rivi Div B[ 5w [ | Bedue |
Hposon [0.00  [5| Level [000 [ | ¥pesttion 000 [5] | ¥postion (000 [%] | Reverse
B s %] | BENalsjsc] | o ] mve_|

AM signal po difoltu ima Ucestanost nosioca od 1000Hz,uc¢estanost moduliSuéeg
signala 100Hz i dubinu modulacije m=1.Kliknite dva puta na AM generator i
podesite dubinu modulacije na m=0.3,slika iznad.

2.primer.

Editujte AM generator da mu ucestanost nosioca(Carrier Frequency) bude 684kHz-
ucestanost Radio Beograda,a moduliSu¢a uéestanost(Modulation Frequency)
400kHz,pa podesite osciloskop da se na njemu vidi signal i to:

«TB na 2ms/Div
*Osetljivost kanala na 2V/Div.
VEZBA 3.

MERENJE FAZNOG POMERAJA.

Merenje faznog pomeraja izmedu dva napona posmatraéemo na rednoj vezi otpornika i
kondenzatora.Posto povezemo Semu,editujemo R i C i podesimo
instrumente,dobi¢emosledecu sliku:
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OIE
> [
CI-I-E
<
¥

&
R
. —— 15.91 k Chm
& | Function Generator !_EE__|
| | e || }
1
Frequency |d = MHz B 10 pF
Duty eycle |50 (3] =
Amplitude [0 H v B
ottt [0 [ T
r Common o
- [ -

Ukljuéimo glavni prekida¢ i sacekamo nekoliko sekundi,prosirimo sliku i
pritisnemo Pause, da zaustavimo sliku.Postavimo pokazivace kao na slici.

] Oscilloscope =
5 wF

\
/-’

B Al
T 19 .8372 ms T2 19 .8374 ms T2-T1 125 BHABA ns
il 9.9178 W iind 7.5474 W SARZ-hd -2.3695 W
WH1 4. 5176 W wB2 &. 9645 W B2 Z2.44673 W
— Time base Trigger Channel & ———— Channel B

0.20us/ div El| elge 1A 2 [ 5 wiDiv B 5 wiDiv = Reduce
H position | 0.00 5| Lewel |00 = | ¥ pesition [ 0.00 2| ¥ pesttion [ 0.00 [2]| Reverse
EE 5n | ~8 [ coto JENICIES Ac|o s arehi] O | Save

Napon veée amplitude(na krajevima veze) je U, a manji U;je napon na kondenzatoru.Fazni pomeraj je:

¢=AT/T*360
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AT=125nsT=1/f=1/1MHz=10 *6..sa dijagrama gore.

$=125*10/10%*360=45

Dakle fazni pomeraj izmedu napona U i hapona U, iznosi 45 stepeni.
VEZBA 4.
DC OPERATING POINT.

Predstavlja analizu jednosmernog rezima.Kao primer prikazano je jedno elektricno kolo
koje se sastoji od generatora jednosmernog napona od 12 V,osamo otpornika ,kalema i
kondenzatora.

i
i
0
(]

U malim pravougaonicima su redni brojevi ¢vorova.Ako ih nema koristite
komandu: Circuit>Schematic Option>Show/Hide.

A sada otvorite meni Analysis.
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)

dit  Circuit | Analysis | Window Help

o = Activate
™

— Pause
= -
| 0 Stop
B
d| 5] Sourc Analysis Options..,
= _—ﬁ DC Operating Point
s AC Frequency...
i _
Transient...
Fourier...
Monte Carlo...

Display Graphs

Ctrl+ 03
Fa
Ctrl+T

=i

Ctrl+

T Ee—
mEE |

Pritiskom na glavni prekidaé€ pojavljuju se rezultati analize:

-

E Analysis Graphs

(= =]==]

D|=(@|@(R] (%[ =] ||

DC Bias |
Node/Branch Voltage/Current
= 12.00000
2 &.00000
Z 3.00000
o 3.00000
& 0.00000
T 3.00000
Lifbranch -3.00000m
WVigbranch —6.00000m
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U koloni Node/Branch su brojevi ¢vorova i oznake grana,a u koloni Voltage/Current
velié¢ine napona €évorova i struje u granama.Svi naponi dati su prema masi

PRORACUN STRUJA KOLA.
1,=U;-U,/R=12-
6/1000=6mA 1,=U,-
U, R,=6-3/1000=3mA
1,=U;/R5=3/1000=3mA
1,=U,-U;/R,=6-
2/1000=3mA 15=U;-
Us/R5=3-3/1000=0mA
Is=Us/Rs=3/1000=3mA
I;=U¢/R7=0/1000=0mA(u grani sa C nema
struje) |=OmA(kalem se ponasa kao
kratki spoj)
Ekvivalentni otpor kola moze se naci kao: R.,=U1/11=12/6mA=2000Q
VEZBA 4.
AMPLITUDSKO FREKVENCIJSKA ANALIZA(AC ANALIZA).

Na slici je prikazana Sema po kojoj se u laboratoriji snima zavisnost izlaznog napona
filtra od ucestanosti.Ucestanost generatora povec¢ava se u malim skokovima i za svaku
novu uéestanost meri se napon na izlazu.Pomoc¢u dobijenih vrednosti crta se grafik,kod
koga je na apcisi u€estanost .. , a na ordinati veli¢ina izlaznog napona.U¢éestanost na
kojoj je U,=0.7 U je GRANICNA UCESTANOST.Ovo program obavlja veoma brzo.

Nacrtajte kolo kao na slici:
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P‘\_\__r U ol R4dU Ley L a0 k Ohm

AC Frequency Analysis Send Fredbsck @

Analyziz
Start frequency [FSTART] |H2 I%
Accept

End frequency [FSTOP] |10 [kHz =

Sweep type Decade | M

Murnber af paointz 100
Yertical zoale Log - |

MHodes in circuit Modes for analyziz

W1 #tbranch Add - =
< Remove |

Otvorite meni Analysis i u njemu kliknite na AC Frequency.Na ekrenu se pojavljuju
dijalog prozor(slika iznad)Tu su izvrSena slede¢a podesavanja:

ePocetna ucestanost(FSTART)podesSena je na 100Hz
eKrajnja ucestanost FSTOP) podesena je na 10kHz

eU prozoruNODES IN CIRCUIT pojavljuje se spisak svig ¢vorova ukolu.U
prozor NODES FOR ANALYSIS treba prebaciti potreban ¢vor,u nasem slucaju

komandom add.
eNa taj nacin ée zavisnost napona izmedu tog évora i mase, biti ufunkciji

ucestanosti izvora. Kliknite na dugme Simulate,otvara se Analysis Graph.
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lg-'il\nal:.-'sisGraphs .
D|=E|S|R| *[%6] s w)
AC Analysis | Statistics [Analog] |

1000m

Voltage (V)

100m T
1K 10K

Frequency (Hz)

I
(%)
1

Phase (deg)

—60 1

100 1% 10%

Frequencv (Hz)

\VEZBA 5.
JEDNOSTRANI ISPRAVLJAC

Na slici je predstavljen ispravlja¢ sa jednostranim usmeravanjem naizmeniénog
napona.koji obrazuju mrezni transformatorMT,dioda Di kondanzator od

1000pF.Nacrtajte Semu i editujte komponenta.

@

38.33m A

11300 Ohm fE0%
5748 W
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Kliknite dva puta na mrezni transformator..U dijalogu Transformer Propertieskliknite na
Models pa na biblioteku powrvolt.Oznake svake komponente pocinju sa PP.Kliknite na

potrebne vrednosti:
ePrenosni odnos 18
*RP=260Q
*RS=4.20
eUkucajte novo ima 220/12 i kliknite naOK
P podesite na 300Q
eVremensku bazu podesite na 5ms/Div
+Osetljivost oba kanala na
10V/Div Ukljuéite glavni prekida¢.,i

zaustavite sliku:

= Uscilloscope
=

oI

L | i i
T G.eeoo = T2 &.1192 = TZ-T1 &.1192 =
St -2 . @281 o SRE @2 1287 mW SR 2 .&6883 o
B S.7485 u B2 12.7749 v WB2-VB1 3.8344 v
— Time base Trigger Channel & Channel B -
[5.00msidie 2] | Edge = [10 wiDiv B | [10 wDiv 1= |
¥ position | 0.00 B | Leval o.o0 = | ¥ pesitien [ 0.00 =] | ¥ pesition [0.00 ] | Reversa |
R B | B N A B| Ba | Ac| o | e Ac | o | e save |

Proverite $ta se deSava kada se C! Povec¢a,a sta kada se smanji-Smanjujte otpornost
potroSaca R,.i posmatrajte pokazivanja ampermetra i voltmetra

VEZBA 6.
DVOSTRANI USMERAC.

Nacrtati Semu dvostranog usmeraca i editovati komponente kao na slici.Mrezni
transformator podesiti na sledece vrednosti:

eDva puta kliknuti na mrezni transformator.lzabrati PP4-20,kliknuti na Edit i podesiti
*Prenosni odnos na 18,3

RP na 260Q



RS

na 4,2

Kliknuti na OK,zatim na Rename,pa ukucati novu oznaku

MT 220/12 Podesiti vremensku bazu 4ms/Div i osetljivost

na 10V/Div

Figure

2200

=i}
=

Hzi0 Deg
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1 4001

s 15 50m &, || ®

[R)1 K Chim /45%

O k4001

Ukljucite glavni prekidac¢,zaustavite sliku | uvecajte je.

7010

& Oscilloscope | E2 _i
~ ~>
B S
T ERCEEEE EREEEE] TZ-T1 EREEEE]
i =.7788 W -g.z198 WAZ-] -1z .9891
BT &. 6785 7.Oz8s WBZ-WE 1 Fa4z.BEZE muy
— Time base Trigger Channel A Channel B
5. 00m=/ div (2] | Bdge = [0 wiDiu = [0 wiDiu [£] | Feduce |
¥ position Lewel .00 = ¥ pesition [ 0.00 2] | ¥ pesition [ 0.00 [5] | Reverse
ST o O ac| o EE ac | o |EE save |

VEZBA 7.RC POJACIVAC SA ZAJEDNICKIM EMITEROM-

Nacrtati sledeée kolo:.
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ﬁ D=

Y
i
W
STATAY.
Y
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1.Podesiti generator funkcija da daje sinusni napon amplitude 5mV,u¢estanosti 1kHz.

2.Snimiti karaktaristiku sa osciloskopa.Vremensku bazu podesiti na
o.2ms/div,osetljivost kanala A na 2mV/div, a kanala B na 200mV/div.Na osnovu
dobijenih karakteristika izmeriti kolike su amplitude napona.Podeliti ih i izraCunati
naponsko poja¢anje pojacivac¢a.(A=U2/U1)

3.1zvrsiti DC analizu i prougiti dobijene rezultate.Na osnovu njih
izraCunati U..,Uy. i I 4.1zmeriti ove napone pomoéu DC ampermetra iDC
voltmetra.

5Uraditi frekvencijsku AC analizu

kola.: FSTART :10Hz

FSTPO :400kHz

Sweep type

:Decade Number of

points :100 Vertical

scale :Linear

Podesiti (izlazni évor) u prozor Nodes for

analysis Simulate-

Izbrisati donju sliku,povecati gornju i postaviti reSetku.
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Progéitati izlazni napon(frekvencija signala na ulazu je 1000Hz,naci poja¢anje ako je ulazni signal 5mV.

Proceniti na kojoj ucestanosti se nalaze grani¢ne ucestanosti,ako se zna da je na
graniénoj u€estanosti izlazni napon 0.707 ulaznog napona.

Menjajte Cul i videti kako uti¢e na graniéne
ucestanosti. Podesiti R1=35kQ i uoditi da je
izlazni signal izobli€en!..

VEZBA 8.

REDNO OSCILATORNO KOLO.

Nacrtajte kolo sa slike.To je redno oscilatorno kolo koje obrazuje kalem L | kondenzator
C.Kapacitivhost kondenzatora C1 je 90pF,a kapacitivhost kondenzatora C2 moze da se
menja.Editujte ovaj kondenzator tako da mu kapacitet bude 20pF,a promena 1 %.Na taj
nacin dobili ste trimer kondenzator ,¢ija kapacitivhost moze da se menja u granicama
od nule do 20pF ,u skokovima od 0.2 pF.Smanjenje kapacitivnosti ostvaruje se
pritiskanjem na taster sa slovom C na tastaturi,a poveéanje pritiskom na Shift+C.

M
e ]

Generator funkcija podesiti da daje sinusni napon ucestanosti 800kHz,amplitude do
5V.Startujte AC analizu.Podesite:FSTART na 700kHz FSTOP 900kHz Vertical scale
:linear.Prebacite ¢vor 4 u desni prozor komandom add,posto predhodno oznacite ¢vor 5
u levom prozoru,a évor 1 koji je bio u desnom prozoru izbrisite.Pritisnite SIMULATE-.
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& Analysis Graphs [EErE=]
D RS &lee wlw s e
AC Analysis ]
500 4

700K 900K
Frequency (Hz)

-50 4

=100

Phase (deg)

-150 1

-200

TOOK 900K

Frequency (Hz)

Uvecéajte sliku pa kliknite na reSetku da vidite kolika je amplitude napona pri rezonanciji.
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PROTEL 98(EDA/CLIENT 98)

Protel je programski paket koji sluzi za
projektovanje STAMPANIH PLOCICA.Stampana ploéa je ploga presvuéena tankim slojem
bakra.Na bakarnom sloju projektuju se Stampane veze(provodnici),izmedu komponenti koje
se lemljenjem pri¢vrS§¢uju za plocicu.Gotov plan Stampanih veza i polozaj komponenti se
odStampa na pausu,odakle se kasnije posebnim postupkom prebacuje na bakarnu
plocicu.Prema broju provodnih slojeva razlikujemo:JEDNOSLOJNE,DVOSLOJNE ili
VISESLOJNE PLOCICE.U ovom programu uglavnom éemo se baviti jednoslojnom
Stampom:sa gornje strane plocice bi¢e smeStene komponente,a sa donje strane stampane
veze.

STARTOVANJE PROGRAMA:
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Program se pokrece klikom na ikonicu :

Server | Schlib Sch PCELib PCE

Uvodni ekran sadrzi:

1.PANEL SA BIBLIOTEKAMA
2.PROJEKT MENAGER
3.RADNI PROZOR

4.LINIJA MENIJA

5.PALETA SA ALATOM
6.STATUSNA LINIJA
7.KOMANDNA LINIJA

Klikom na odredeni jeziCak EDA EDITOR TABA aktiviraju se sledeéi programi:

PCBProgram za PROJEKTOVANJE STAMPANE PLOCICE

PCB lib.......... Program za rad sa BIBLIOTEKAMA ELEKTRIGNIH KOMPONENTI.
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Sch....... Program za CRTANJE ELEKTRICNIH SEMA

Schlib ..... Program za rad sa BIBLIOTEKAMA SIMBOLA ELEKTRICNIH KOMPONENTI.
SERVER ..Definisanje novog servera

SPREAD...Tabelami prikaz podataka vezanih za projekt

TEXT ..Kreiranje i izmena text dokumenta

WAVE....Program za definisanje signala potrebnih za simulaciju rada elektricnog kola

SCHEMATIC DOCUMENT EDITOR-SCH

Ovo je program koji sluzi za crtanje elektri¢nih Sema na racunaru.Objedinjuje rad dva
programa: 1.Program za crtanje elektri¢nih Sema
2.Program za kreiranje novih i zamenu postojecih elektricnih komponenti u

bibliotekama. Startovanje SCH programa sa Editor EDA TABA:
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LS EES LM WY/ #5000t BEY V2 Wi vo?

o
£
Libray )
2 3 8] CA\Client08\Sheet 1.5ch =T
0 i
¥ Adid/ Remove
5 : :
@ Companents [n Library 5 : i : ; R
2 ek
:
E OravingTaols A F 1
& /EELT
o O0eCHE
i
i ™ -
O |t | e | Frd |
o WiringTools. X
" B b wEDE

y Fuer 3T LI KB

Vva

Faity W

Mask |"

V' Pata Inomation

Tewt | Jump | Edit
Update fist M [

= ]

e

# RB0YE)

" |l state - 1eady for command

Otvara se radni list sa propratnim radnim okruzenjem kao na slici.Paleta sa alatom Main
Toolbar proSiren je i sadrzajem alatki za otvaranje,snimanje dokumenta,kopiranje i
premestanje.Panel sadrzi i biblioteke Driving tools i Wiring tools u posebnim
prozorima.Postavljanjem miSa iznad odredenih ikonica videti njihov sadrzaj.
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Crtanju elektricne Seme predhodi podeSavanja okruzenja radnog lista SCH
editora.Ovo se postize komandom:Options>Dokument Options:

| e e e
-

Document Options

o e o e

......................................

E Template - Standard Style

E File Mame : Mo Template File Standard styles |B -
i Options Grids ; Custam Style

It Orientatiar - v SnapOn (10

i |Land$cape —-| e E [ Use Custom style

1| | = TiteBlack [Standard =] || ¥ Visble 10 P 00

.:.' [v Show Referernce Zones Electrical Grid Elkelam bl |ETDD_
i [v Show Border [+ Enahble

1 ) # Ref Region Count |4

3 [ Show Template Graphics GridRange |2

' Ref Region Count |4
: Margin ‘width [0

shest Lolor | Change Spstern Font |

o o

k. Cancel | Help

o o e e

U dijalog prozoru postavljaju se slededi
parametri: STYLE-Standard ili Custom
OPTIO

NS

GRIDS

ELECTRICAL

GRIDS CHANGE

SYSTEM FONT

Kompletna elektricna Sema sadrzi:elektri¢ne
komponente,provodnike,napajanje,uzemljenje,Evorove,labele i
tekstove.

Crtanje elektriéne $eme poéinje uzimanjem el.komponente iz aktivne biblioteke i
postavljanjem u radni list.Aktivna biblioteka je zapisana u prozoru okruzenja.lspod tog prozora
nalazio se prozor sa sadrzajem aktivne biblioteke.
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Formiranje liste otvorenih biblioteka obavlja se na sledeci nacin:klikne se na dugme
Add/Remove ¢ime se dob ija dijalog prozor Change Library File List:

W Change Library File List e S
Look in:‘ | Library j = £ B~

Name Date modified Type Size

ml »

| Actel

J ALLEGRO
| Altera

; AMD

| ATRT

1 Atrmel

Description : Mot Available

Files of type: | Allfiles(".") =]

Selected Files:

Add Femove | | k. | Cancel

U gornjoj polovini dijalog prozora bira se biblioteka koja se dodaje na listu otvorenih
biblioteka,a u doniju listi dolazi lista izabranih biblioteka.To se postiZze tako Sto se biblioteka
odabere i pritisne dugme Add,ili dvostrukim levim klikom miSa.Odabra¢emo biblioteke

Client\98\Sch98\Library\AMD\Amcodac.lib
Client\Sch98\Library\Device.lib
Client\Sch

98\Library\intel\D.intel.lib

Komponenta se uzima iz aktivne biblioteke tako Sto se markira ili se klikne na dugme
Place,ili se uradi dvostruki levi klik na izabranoj komponenti.Pomeranjem misa
komponenta se dovede na zeljenu poziciju,a levim klikom misa fiksira na radnom

listu.Rotiranje komponente vrsi se tasterom Space.
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Na slici je prikazano postavljanje otpornika iz Device.Lib sa oznakom RES2 na radni
list.Otpornik se fiksira levim klikom.Na vrhu kursora se i dalje nalazi otpornik ako je
potrebno jo$ otpornika.Desnim klikom se zavrSava postavljanje otpornika na radni list.

ELEKTRICNA SEMA REDUKTORA NAPONA

Na slici su postavljene komponente za elektricnu Semu reduktora napona.

! Qo IF?
= ! NPN1 1
1 O——— -Off\%ulf} ““—\'\ 5 e —_— ;
o e yrtr T
HEADER 2 RES? Nm (EENRAREY HEADER 2
Q?
_ Tcap
AR,
A i

Editovanje podataka vrSi se tako $to se dva puta klikne na komponentu,ili EDIT>CHANGE
otvori dijalog prozor PART.U njemu se pod opcijom ATTRIBUTES upisuju sledeci podaci:

LIB RIFime komponente u SCH bibliote ci(automatski se
upisuje) FOOTPRINT (otisak)-ime komponente u PCB
biblioteci DESIGNATOR-0znaka komponente na elektri¢noj
Semi

PART TYPE-ElektriCna vrednost(kataloska oznaka komponente)



PartFields 316 | = ReadOnly Fields |
{Aitibutes Y| Graphical Ats | Part Fields 18 |

. Footprint IMIQLUA = _:J

' 'D’ésignatnr : 19

Part Type [1?&2

o 'SIHeet Path [

Bt ]

i Sele;:tinn g o
H'id:i:fen.F’ins T“".

| fren T

_: Fir_ald _Names ' 5

w0 e

l

=

i iCemgel Global »>
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Na slici su prikazani podaci za otpornik RES2.Na radnom listi biée vidljivi samo Designator i
Part Type.Za primer reduktora napona Sema izgleda kao na slici dole

.08
t:n—— —of\_jo-
. mz

R

U dijalog prozoru PART moguce je podesiti i:

Tl
2N3055

BC107 !

1K2 N

A

C
IDUHFI
i

L, D

ZF4 .3

KONZ2

—)

1

S = BB

3V
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Orientation-polozaj komponente

X-locationX kordinata poloZaja komponente
Y-LocationY koordinata polozaja

Fill colorboja komponente

Line colorboja okvira komponernte

Pin colorboja priklju¢ka komponente

Local coloromogucéava izmenu navedenih boja

Foot printovi za reduktor napona AXIALO.4 FUSE...DIODEO.4...SIP2...T1 TO-3 T2 TO-18 C-RADO.4

CRTANJE VEZA IZMEDU KOMPONENTI

Crtanje provodnika po€inje opcijom PLACE>WIRE ili aktiviranjem ikonice iz palete Wiring
tools-Levim klikom miSa zapocinje crtanje,a zavrSava desnim klikom.Svako skreta nje vrsi se
levim klikom mi3a.

Y IEEERra VSN B W
1P 5 T2
{\
|
ke D
AN 7

¥ A : ot ﬁ_.
¥ : : i i : [

Editovanje provodnika ostvaruje se dvostrukim klikom na provodnik,Eime se otvara dijalog
prozor Wire u kome se definiSu debljina Wire width i boja provodnika Color,a moguce je i
selektovati provodnik.Posle spajanja svih komponenti dobijena je slede¢a Sema:
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KON

12V

CRTANJE CVOROVA

Cvor se moze nacrtati opcijom Place>Junction,a mogu se postaviti i
automatski:Options>Preferences>Schematic>Auto Junction .Posle postavljanja ¢vorova
slika reduktora napona dobija konacan izgled.

¢l 2,

1Y

CRTANJE NAPAJANJA | UZEMLJENJA
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Napajanje-uzemljenje elektritnog kola crta se opcijom PLACE>POWER PORT.Editovanje
napajanja postiZze se devostrukim levim klikom na simbol napajanja,posle ¢ega se izabere
odredeni oblik u dijalog prozoru Power Port.Na slici su prikazani svi simboli za napajanje i
uzemljenje.

e ‘*’CCVCCWC_J_J_, - %7
BERNEF SR anNERRNL RN N
Cick ~ Amw ~ Bw ~ Wer — Powr ~ Sigal  Eath
) W | 5 e Gromd Ground

CUVANJE NACRTANIH SEMA
Nacrtana i editovana Sema moze se sacuvati pod odredenim imenom na adresi.
C./Client 98/Sch 98/Examples/ima

fajla.sch Opcijom File>Save

Save Document As

Dol ale

Savein I “§ Examples

1 Xilinx2k =] B0xx.sch {=] Eesoflb.sch =] Ld1111.sc
1 Xilinw3k 8] Atbuss.sch ] Eesaf2.sch ] Ledsch
1 Xilinxdk ‘] Baudclk. sch 3} Eesof3.zch gl] Memory.sc
|1 Xilinx7k ] Cpu.sch 3} Eesof4.sch _;‘E-i Power.sch
] 20mfm.sch i#] Cpuclk.sch ﬁ Floppy.sch ﬁ] Ppisch
] 34pin_hd sch 4] Eesoflasch g} Floppy2.sch gﬂ Pspicel.sc

File name: - {reduktor napond

ngé as g.!pE.'; ]Advancedﬁchematlc Eiﬁéry[".sch]

ZADATAK 1

1.Startovati paket EDA/CLIENT 98
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2.Startovati program za crtanje elektri¢nih Sema SCH editor.
3.Podesiti

1. Vodoravan polozaj radnog lista

2. B format radnog lista

3. idljivost mreze Visible Grid:10

4.elementarni pomak kursora Snap On:10

5. dejstvo elektricnog ¢vora Elerctrical
Grids:8 4.Aktivirati  biblioteku elektri¢nih

simbola Device.lib

5.Nacrtati Semu sa slike,imena u PCB biblioteci(FOOTPRINT) za komponente sa slike su:0S-
FUSE GREC- FLY4 C1-POLAR1.2 C2-RADO.4 C3-RADO.4 C4-POLARO.6 D-
DIODEO.4 R-AXIALO.4 IC-TO- 220

6-Semu snimiti pod imenom Ispravljaé.sch u folderExamples:C:/Client98/Sch/Examples/

05 -

.24 ' -
vo—ol |0 I Em e S
s 1 paclonn K€
: ' ' RN ~ LM7809 .
o L ot - 04V
a
iy
. : Smm
e o0
- 4
40l et 100uF 100 . R ,_F‘,r 1
470FH16V 1DuFH+10V 1K50.25W

POVEZIVANJE SCH EDITORA | PCB EDITORA

Pre prelaska u PCB i projektovanje stampne plo¢e,neophodno je kreirati NET
listu.Ovo se vr§i komandom Tools> Create Netlist.,nakon ¢ega se otvara dijalog
prozor kao na slici:
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Netlist Creation M

Freferences I Trace Dptiu:lnsl

Output Farmat
.

MHet [dentifier Scape
i Sheet Symbal / Part Connections

Action after Hethizt Generation
I Mo Action

[ Current sheet only
v Append sheet numbers to local nets
[T Descend into sheet parts

[ Include un-named single pin nets

U njoj se podesavaju odredeni parametri koji se odnose na format strukturu projekta
,radnje nakon kreiranja net liste.Nakon podeSavbanja kao na slici na ekranu se pojavljuje
sadrzaj NET liste,sa ekstenzijom.net.Na slici ispod prikazana je NET lista za REDUKTOR
NAPONA.net kreirana za elektricnu Semu reduktor napona.sch.Net fajl sadrzi spisak
komponenata elektricne Seme,sa imenima iz PCB biblioteke i elektricnih veza izmedu
priklju¢aka(pinova) tih komponenti.Sa formiranom NET listom mozemo preéi u PCB i
zapoceti proces projektovanja Stampane plocice.
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File Edit View Tools Simulate PLD Window Help
=R & «,34 oL e
- s Ducumeznt* ELE
L ki iy 5 soh
@ ’reduf tor napona. sc e i
w1 reduktor napona MET 1Ko
Search Clear i
]
[
Tl
TO-3
2H3055
]
{
TZ
Goto TO-18
i BC107
i l_“ Case sensitive
! n 'W'haleWard -
f“ All Textﬁccs . ]
S e g 4 EA R R R R | {
= Lacatmn Ma{kers Lt NOOOOD1
; _ KON1-1
_ -IH*' I““E “_I ?5—1
‘12f“-'f.r_7*__1-: b (
§qr e o | NO0O0D2
; - iip
. -—“j . . r*g__J 0 KON2-2
s o ag ] D—4

PCB EDITOR(PCB)

PCB(Printed Circuit Board) je program pod EDA/Clientom koiji sluzi za Stampanje elektri¢nih
plocica.Objedin juje dva programa:

«PCB Editor
*PCB Library editor
PCB se startuje na jezi€ak

PCB
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%% File Edit View Place Design Tools AutoRoute Reports Window Help
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]
o
a
-;:; Browze =
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= CAClientd8\PCB_1.PCB
5
]
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o |
o
0
E Edi.. Zoom
@ | Modes
=
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z
(=8
0
=
o
o
2 ; |
o Edit... Jump
=
————
Configure ' b agnifier |
Current Layer
Top Layer _ﬂ -
4 =
|\ TopyBot ATOwver i KeepOut i echl /ibulti/

Otvara ae radni list C/Client98/PCB-1.PCB sa radnim okruzenjem kao na slici.Sacinjavaju ga dva prozora:
eControl Panel
eProject

Menager Otvorene su

Linija menija,paleta alata (Main Toolbar),linija programa (EDA Editor Tabs),statusna
linija,komandna linija,paleta alata i linija spojeva.
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Linija spojeva nalazi se ispod radnog
lista(Top,Bot, Tover,KeepOut,Mech1,Multi),predstavlja imena uklju¢enih spojeva.

PODESAVANJE RADNOG OKRUZENJA

PodeSavanje radnog okruzenja sastoji se od sledecih koraka:
1. Definisanje koordinatnog pocetka

Ostvaruje se komandom EDIT>ORIGN>SET Koordinatni poéetak je oznaéen ZUTIM
KRUGOM,ukoliko je predhodno uklju¢en Tools>Preferences<Show/hide>Show Orign
Marker>Ok .Apsolutni koordinatni pocetak je u levom donjem uglu radne povrsine,a ako je
aktiviran neki drugi vraca se sa Edit>Orign>Reset

2. Definisanje slojeva(Layers)

Projektovanje Stampane plocice ostvaruje se postavljanjem komponenti na
odgovarajuce slojeve(Stampana plocica je viSeslojna),komandom Design> Option

i : : : : : : ) . il

Lavers ] Options |

- Signal Layers r Internal Flanes — — Mechanical 1 Dol Layers -
W Top [ Midg [ Plane1 v Mech [T Dl Guide
[ Mid1 [ Mid9 [T Flane 2 [ Mech? [T Dl Drawing
[~ Mid2 [~ Mid10 I~ Plane 3 [ Mech 3
[ Mid3 [~ Mid 11 [T Plane 4 [ Mech 4
[ Mid4 [ Midi12 | - =
[ Mid5 [~ Mid13 | [ SolderMask = Paste Mask - Silkscreen-
[~ MidE ™ Mid1a || [T Top I~ Top v Tap
[ Mid? [v Bottam [ Battarn [ Bottom I Ealiom
— Oth
e ._. Al On
W KeepOut | Connect [ Visble Grid1 |~ PadHales T
[w MultiLayer [ DRCErarz W Visble Grid2 [~ iaHoles Used On
'''''''''''''''''''''''''' 0K ]  Carcsl Help

Ovde se uklju€uju potrebni slojevi:

TOPIAYER -jc sloj na koji se postavljaju KOMPONENTE i PROVODNICI(§tampane veze)
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BOOTONIEAYER-doniji sloj plocice na koji se obiéno postavljaju Stampane veze(provodnici)

TOPIGVEREAY (ne postoji na stampanoj plogici,sluzi za lakse i preglednije
projektovanje,namanjen je za prikaz okvira komponente i teksta uz komponentu)

KEEPIOUTIEAYER-jc sloj za crtanje ivica plogice.Sve komponente i veze moraju biti unutar ivica.
MUBTIEAYER-Ovaj sloj se koristi za postavljanje rupa(pad) i prelaza(Via)

EONNEET-sloj za prikaz linija veza

VISIBEEIGRID2-S0j za prikaz pomoéne mreze

3. Definisanje boje slojeva
DefiniSe se opcijom
Tools>Preferences
4. Definisanje mernih jedinica i pomoéne
mreze U PCB se koriste dve merne jedinice MILS
i MILIMETAR 1inc=2.54cm
1mil=0,001inc
100mil=2.54mm
1mm=100/2.54=40
mil
1Tmm=40mils

Merna jedinica se deSiniSe u Design>Option>Document option(odabere se Imperial(mil)ili Metric(mm)

Layers Options 1

— Gnds — 7 [ Electrical Gnd -
Snap ]20"“" I+ Enable

Yisible 1 ]2Dmil Grid Ranage iElmiI v]

Visible 2 [T000mi e

Yisible Kind ]Lines Meazurerment Unit  |Imperial -

— Engineering Change Orders

File: [FCE.ECO

Cancel
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Pomoéna mreza omogucuje lak$e postavljanje objekta na radnu povrsinu.Podesavanje
dimenzija mreze(stranica kvadrata) vrSi se u dijalog prozoru sa aktivnim jezickom Option,slika
gore.,pod opcijom Visible 1 ili Visible2.MreZa moze biti prikazana punim linijama u opciji Visible
Kind(lines).ili tatkama u opciji Visible Kind(dot).U istom prozoru definiSe se i:

eElementarni pomak kursora opcijom Snap
eElektricna mreza pod opcijom Electrical grid(enable)

ePodrucje delovanja ¢vora pod opcijom Electrical Grid>Grid Range
DIMENZIONISANJE PLOCICE

Stvarna veli¢ina ploCice zavisi od broja iveli¢ine komponenti koje se na nju
postavljaju.Dimenzije plo€ice izrazavaju se u in¢ima ili milimetrima.Plocica se crta u Keep Out
Layer-u ,komandom Place

>Track.Aktiviranje sloja vrSi se levim klikom na istoimeni jezi€ak koji se nalazi u liniji slojeva
Keep Out Layer.Pocletak i kraj linije se potrvduje pritiskom na levi taster miSa.Nacrtani okvir
plocice uvecava se- (umanjuje)tipkama Page up i Page Down ili sa View>Zoom in>Zoom
Out ili lupama + ili -.

Za ilustraciju projektovanja Stampane plocice,posluzi¢enSema Reduktora
napona.Dimenzionisanje i ctranje plocice veli¢ine 3000x2000mils(75x50mm) prikazano je
na slici.Radi preglednosti koordinatni po€etak(X:0,Y:0) postavljeno je na mesto koje
pokazuje kursor na slici:

P

Top ABot ATOver 4 KeepOut i MechT AMuli
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UCITAVANJE NET LISTE

Pre ucitavanja NET liste MORA BITI AKTIVNA BIBLIOTEKA SA POTREBNIM KOMPONENTAMA 1Z
PRIMERA

A TO JE BIBLIOTEKA ADVPCB.LIB,koja se nalazi na adresi C:/Client98/PCB/Library,na
isti nacin kao i u SCH Editoru komandama Design>Add/Remove Library.Ako se u
projektovaniju poloc€ice koriste komponente i iz drugih biblioteka,potrebno je otvoriti i te
biblioteka.UcCitavanje NET liste vr$i se komandom:

Design>Netlist otvara se prozor Load/Forward Annotate Netlist

Load:’Fomard Annolata Netlist
Neihsti Sl

! ;Lnade’Fafward Annotde N etllsl

 This operation brings the schematic desagn- ata
| database are made explicitly through Netist Macros. T
- boththe nethsl file and the internal PCB deslgn dalaha

r‘ Qeielc compunents nnt ih

lNEH!SE Macms e

e . |
122 Addnode A2 to net NODOO3 T Al
123 Add node T1-COLLECTOR to net NOODD3 ‘Enor: Node Not found
24 Addnode TZCOLLECTOR toretNDODO3 ~ Enror: Node Not found

%5 Addnode DK to net NODDD4 s

26  AddnodeR-ltonetNOODA

27 AddnodeT2BASEtoretNDOOD4  EnmorNodeNotfound G
28 _Add node T1-BASE ta net NDOODS 5 Enrar: Node Not found _ --J ?
8 Addnode T2EMITTER onetNOOOOS ~ EnorNodeNotfund

! e L

'3 ,:E_Siatus : Serrors crund

.; -gmnséd.};}' B

il CE!NCBI
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Klikom miSa na Browse bira se odredena NET lista.Sam program trazi komponente za NET
listu(Footprint)u PCB bibliotecii ucitava veze izmedu priklju¢aka Pad-ova i Nod-ova.Lista
sadrzi spisak svih ucitanih i neucitanih komponenti i veza.Neucitane komponente i veze
oznacene su kao greSke Error.

KOMPONENTA necée biti u€itana ako se dodeljeno ime Footprint komponente ne nalazi u PCB
biblioteci,i toiz sledecih razloga:

«Greska u pisanju(pogresan karakter)
eDodeljeno je nepostojeée ime u PCB bibluioteci

«Veze neée biti uéitane ako imena prikljué¢aka u PCB (Pad,Nod)nisu INDENTICNE.
PRIMER1:

Pri ucitavanju reduktor napona .netformirana je lista u prozoru iznad.U listi su zabelezene sve greske
,koje su se javile pri u€itavanju komponenti i njihovih veza.Vidi se da su sve komponente

sadrzane u ADVPCB biblioteci u€itane.ispravni Footprintovi,ali da nedostaju veze,koje nisu

ucitane zbog razligitih imena priklju¢aka komponente u SCA(to su priklju¢ci emitter,base i
collector),u odnosu na iste u PCB(1,2,3)

KOREKCIJU moramo izvrsiti u Netlist Macros listi zamenom prikljucka.

To se u naSem primeru vrsi dvostrukim klikom misa na T1-COLLECTOR i u novom
prozoru NETLIST MACROS briSe naziv COLLECTOR i piSe broj 3.Isti postupak vazi i
za ostale priklju€ke tranzistora.

e EI’DWSE A

[ Delete components not in netlist I Update footprints

 Mellist File |D-\Client38\5chg8\E xampleshreduktor napona NET

Netlist Macros

{No. | Action ,, . PG -
122 Add node R-2 to net NODOD3 =
153 |Add node T1-COLLECTOR to net NOOOD3
124 Add node ; : i s —
. 25 &dd node ¢
26 Add node

Macros :
27 Add node
98 Add node | Macro Command o
29 Add node = Add Node - Mode [T1-3
Eow—— | e '
Sl 1l e Component - 1 © Net [NDOOD3
= |  Remove Node - -
; Advanced... l | € Remove Net
—_———— | T Hemove Component
" Change Net Mame s
(~ Change Component Footprint
" Change Component D esignator
L.

Change Component Commerit

0K Cancel
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Nakon ispravke svih greSaka aktivirati taster EXECUTE.Ovim se sve komponente
prenose na plocCicu.Veze izmedu priklju¢aka raznih komponenti(PADOVA) prikazane
su pomoénim vezama.

RAZMESTANJE KOMPONENTE NA PLOCICI

Rayme[tanje komponenata vr[i se ru¢no ili automatski.Automatsko razmestanje aktivira se komandom:

Tools>Auto place.lzvrSenjem ove komande kreira se dokument Place_1.Plc na slici
ispod.On predvida optimalan raspored komponenata na plodici.Ovakvih dokumenata moze
se napraviti viSe,pa potom odabrati najpogodniji.Za Semu reduktora napona na slici ispod
prestavljena je Sema automatskog razmestanja,a ako se ponovi postupak dobiée se novi
raspored i novi dokument:
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UNOSENJE ODABRANOG RASPOREDA NA PLOCICU VRSI SE KOMANDOM Update PSB iz File menija
Global Placer Server(kada je aktivan Plc dokument.Rezultat unosenja za reduktor
napona iz dokumenta

Place-1.PIc izgleda kao na slici ispod:
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Rucéno razmestanje komponenti vrsi se komandom Edit>Move>Component levim
klikom miSa na komponentu koju treba premestiti na drugo mesto ili prevlacenjem
komponente pomoc¢u miSa.Komponenta se rotira tasterom SPACE

B | ;
i RN . R
il

-

RUTIRANJE-IZVLACENJE STAMPANIH VEZA

Crtanje veza obavlja se u Bottom Layer-u za jednoslojnu Stampu .Ova aktivhost se moze
obaviti automatski i ruéno.

1. AUTOMATSKO RUTIRANJE

Pre rutiranja potrebno je zadati odredena pravila crtanja raznih objekata na projektu Stampane
plocice. komandom Design>Rules posle ¢ega se otvara dijalog prozor Design Rules
(ispod)u kojem definiSemo pravila crtanja.Ovde su navedena neka:

Clearance Constraintdefinisanje minimalnog rastojanja izmedu komponenti
Pad,Via,Track na nekom sloju

Routing Cornersdefinisanje pravila za crtanje uglova pri izvlaenju veza-
Routing Layers definisanje nacina koriS¢enja sloja(ako se koristi) pri rutiranju

koje moze biti Horizontalno ili vertikalno.



Routing |Manufacturing| High Speedl Other I

Fule Classes —Clearance Constraint

I_ZIE-:r-:lr ce Lorstraint Definez the minimum clearance allowed between
Houting Comers ar bwo priritive objects on a copper laver. Use
Routing Layers the Clearance Constraint to ensure that routing
Fauting Priarity clearances are maintained.

Fouting Topalogy
Routing Yia Style
Width Conztraint

Scope Details Gap

(Board Board) - Differert Nets Orly Ao |

Delete | Emperties_.l

BunDRC... |

Routing Prioritydefinisanje prioriteta crtanja od 0 do 100

Routing Topologydefinisanje naCina povezivanja priklju¢aka.Praktikuje se da veze izmedu pinova
budu Sto krace.

Routing Via Styledefinisanje pravila za crtanje Via(njen unutrasnji i spoljasnji pre¢nik
Width Constraint...definisanje minimalno,odnosno maksimalne

Sirine trake Kada se ova pravila rutiranja podese,zapocinje proces

rutiranja komandom

Sve Stampane veze bice izvu€ene u sloju Bottom Layer(Any),ostali slojevi se ne koriste(not used)
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- Width Con

{NotUsed

Not Used

Not Used

Not Used
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Ostale komande automatskog rutiranja su:

Auto Route>Net....Ovom komandom je potrebno levim klikom oznaciti pomoénu vezu,za koju
treba povuci Stampanu vezu.lzvladi se veza izmedu svih priklju¢aka koji su medusobno
povezani.

Auto Route>Connection

Ovom komandom se povlaci Stampana veza izmedu dva priklju¢ka,ali samo tamo
gde postoji konekcija(pomocna veza)
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Auto route>Component

Aktiviranjem ove komande i oznagavanjem komponenti sa ploCice,povlace se sve veze koje
spajaju ovu komponentu sa nekom drugom komponentom na plocici.

Auto route >Area

Ovom komandom biée izvu€ene sve Stampane veze koje krecu iz priklju¢aka obuhvaéenih blokom:
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Ruéno izvlaéenje Stampane veze zadaje se komandom.

Place>Trackali pri tome uvek mora da bude aktivan sloj u kojem se Zeli Stampana
veza(Botom Layer)Crtanje Stampane veze izmedu prikljuaka je proizvoljno i ne mora
postojati pomocna veza

RS e I i A DT 3 e N B A A ﬁ

Postavljanje metalizirane rupe Vie
VrSi se komandom:Place>Via
Postavljanje rupe Pada vrsi se komandom:

Place>Pad

EDITOVANJE ELEMENATA STAMPANE PLOCICE

Elementi [tampane plo;ice su>
eKomponente
eStampane veze
erupe
emetalizirane rupe
otekst

Editovanje pocinje dvostrukim levim klikom na elemenat.
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EDITOVANJE KOMPONENTE

Uklju€ivanjem dugmeta Properties dijalog prozora Compenent mogu se menjati Designator(oznaka
komonente),Coment(vrednosti) i Footprint(imena u PBC biblioteci)

Designator [KONT

Comment I1 -
Footprint {HAD 0.4

Layer ITop Lay.er _:_l
Hotation 1270_5[]0 '
*-Location iE2Umi] =

Y-Location [7720mi

Lack Prims g

Locked i
Selection I
l . oK | Help : !
 Cancel ] Global >> |

U prozoru Layer menja se aktivni sloj za komponentu.Zapis koji se odnosi na oznaku odnosno
vrednost komponente,moguce je menjati samostalno,ako je on vidljiv na plog€ici(ovo se odnosi
na bilo koji String).Zapis je vidljiv ako je opcija Hide iskluCena.Na slici ispod za Reduktor
napona komponente su VIDLJIVE.
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U otvorenom dijalog prozoru Pad i sa aktivnim dugmetom Prosperties mogu se izmeniti:

Shape....... oblik
Designatoroznaka
Hole size....dimenzija rupe

Layer.......... aktivan sloj



Rotation. ....poloza;..

U aktivnom dijalog prozoru Track moguce je podesiti:

F‘roperties. ] ' o
Width -
Layer : chttum Layer :_I
Net  [Noooos >l
Locked 1t
Selection 1
 Stae-x  [1170mi
Stat-Y  [1480mi
Erd-X  |1520mi
End-y [1480mi
okl e
Cancel |  Global>
Width.......sirina trake
Layer......... aktivni sloj trake
Net.............. veze(mrezu)koje gradi traka

Start-X pocCetne X koordinate

trake Start-Ypocetne y-

koordinate trake End X zavrs$na

x koordinata trake End =Y

zavrSna y-koordinata trake.

Aktivno dugme Prospeties u dijalog prozoru Via omogucuje sledec¢a podeSavanja:
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ropmenaensd]

 Diameter  [EH

Hole Size  [28mil

| ~LayerPar f]Top-Bottam :_l

'_X-Lbc_;a_tinn' .11325mil

L -Y-Loc_atipn : ﬁ 345mil
e e
Selection . =

oK S hHek

 Cancel . Global »> =

Diametar ...... spoljasnjeg precnika

Hole Size....... unutrasnjeg precnika

Layer Pair slojeve koja spaja ova metalizirana rupa
X-Location....poloZaja po x osi

Y-Location.....poloZaja po y-osi

EDITOVANJE STRINGA(ZAPISA)

U dijalog prozori String moguce je menjati slede¢e parametre:
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Properties I

Tenxt |

L L

Height |60mil

Width |1 Omil

Font iDefauF{
Layer %Bnttom Layer
Fotation | 0.000

X - Location  [820mil

‘¢ - Location {2295mi|

Mirron =
Locked i
Selection )
OK | Help
Cancel [ Global 5>
Text........ sadrzina zapisa

Height.....visina znakova
Width ...... debljina znakova
Font......... oblik slova
Layer-....... aktivan sloj
Rotation. polozaj
X-Locationpolozaj po X osi
Y-Locationpolozaj po Y osil

Komponenta se uklanja sa projekta Stampane ploc¢ice komandom Edit>Delite

ZADATAK 1

1.Kreiraj NET listu za Ispravljaé.sch
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2.Startuj program za projektovanje Stampanih plo¢ica PCB

3.DefiniSi sledec¢e radno okruzenje:

a) Ukljuci slojeve Top Layer,Bottom Layer,Top Overlay,Multi Layer,Keep Out Layer
b) Ukljuc€i mrezu predstavljenu tackama na rastojanju od 1000mil

(Visible Grid 2) v)Ukljuci elektricnu mrezu Electrical Grid na 8 milsa

g)Ukljuci marker koordinatnog pocetka(Tools>Preferences>Show/Hide>Show
Orign Marker) d)Za automatsko rutiranje uklju¢i samo Bottom Layer(jednoslojna
Stampa)

4.Proizvoljno postavi koordinatni poCetak

5.Nacrtaj okvir Stampane plodice dimenzije 3000x2000 milsa

6.Ucitaj NET listu i ispravi greSke

7.Rasporedi komponente prvo automatski po zatim ru¢no

8.l1zvuci elektri¢ne veze pravecdi jednoslojnu Stampu,samo u Bottom Layeru
9.Stampane veze na $tampanoj plogici editovati na debljinu od 25 milsa.Oznake elektri¢nih
komponenti u€initi vidljivim.

10. Snimiti Stampanu plocicu pod imenom Ispravlja€.PCB u folder Examples na adresi:

C:/Client98/PCB/Examples/.

3a cBe HeoymMuLe jaBUTU ce NpeaMeTHOM HacTaBHUKY Ha e-mail:
svasilic2020@gmail.com



